
Introduction
Adobe Premiere Pro is a professional-level non-linear video editing application. While it’s easy to make movies with 
simpler programs like Apple’s iMovie, you’ll soon hit a brick wall the moment you try to do anything sophisticated. 
Enter programs like Premiere Pro CC which are sophisticated enough for doing high-end professional work, flexible 
enough for a wide range of  media makers, yet anyone can master the basics with a reasonable amount of  practice. 
Adobe Premiere Pro will confront you with a learning curve, but if  you keep up in the workshop and review the steps 
in this handout as practice between meetings while remaining focused on the fundamentals, you be off  to a good 
start editing. Find a project you want to cut immediately after the workshop to reinforce what you’ve learned.

Creating a new project and a sequence
These are important steps you should follow closely:  

1. Launch Premiere Pro

2. You will see a “welcome window” giving you the choice of  creating a new project, opening an existing project,
or getting help.

3. Choose “New Project.” Premiere Pro will come back with a “New Project” window.

4. Give your new project a name, e.g. “My Project”

5. In the New Project” window you’ll see a “Location:” pop-up with a “Browse...” button, click on the “Browse...”
button.

6. Premiere Pro will display a dialog box asking you to select the destination path for your new project. Navigate to
your project folder, “Adobe [AvidISIS] => Course Name => Project Folders => Your Name”

7. Once you’ve located your project folder and selected the folder by clicking on its name and then click the
“Choose” button.

8. Mow click on the “Scratch Disk” tab (in Premiere Pro, whenever you see blue text, it’s clickable)

9. In the Scratch Disk tab make sure everything is set to “Same as Project.” Premiere creates a lot of  temporary
preview files and for this class you want to keep everything in the same folder as your project.

10. Make sure you selected the proper folder by looking at the “Location:” pop-up in the “New Project” window. It
should show the path to your project folder (if  you’re working in a lab environment, the folder should be on your
own external hard drive.  By default, Premiere Pro will store all of  the files it creates that are related with your
project (including captured and preview media) in your project folder. This enables you to keep all of  your
media assets in one place and thus easy to find. If  this path is not correct, click on the “Browse...” this is a
change button again and identify the location of  your video project folder again. It’s very important that you tell 
Premiere Pro the correct location of  your video project folder.

11. Click on the “OK” button to create the Premiere Pro project file, which will be created in the project folder you
specified in step 10.

12. Premiere Pro will now display a “New Sequence” dialog box in which you can specify the settings of  the first
sequence (timeline) in your project. You should choose a video format identical to the format of  the majority of
the video footage you’ll be working with.  Note: You can take care of  this later when you start editing. If  the first
clip you drag into a new sequence does not match the format of  the sequence, Premiere will ask you to change
the sequence settings to match the clip or to keep the same settings. Given the clip is in the format you want to
edit in, changing the sequence settings to match the clip is by far the easiest way to deal with sequence settings.

13. Type in a name for the sequence in the text box next to “Sequence Name”

14. Now you can finish up creating your new sequence by clicking the “OK” button. Note there are other tab for
“Settings” and “Tracks” but when starting out it’s best to leave all the settings at their default value. The
sequence will appear in your Project Pane along with your other files media assets. If  the sequence does not
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appear in the Timeline Pane, double-clicking on it in the 
Project Pane will open it in the Timeline Pane.

Now you’re ready to start editing. The following sections will 
cover the Premiere Pro workspace and walk you through the 
process of  reviewing media, placing media in a timeline, 
performing editing operations on both your video and audio 
tracks, and exporting your final sequence in the appropriate 
format for screening and critique in class. 

The workspace 
In he Premiere Pro workspace each item appears in its own 
panel (a.k.a. window pane) and multiple panels can be docked 
where you’d like. If  the workspace does not look familiar you 
can reset it by choosing the menu “Window > Workspace > 
Editing” and then choose “Window > Workspace > Reset 
Current Workspace...”. 

Here’s an overview of  the various components of  the 
workspace:

A. Timeline: The timeline is where you’ll do most of your 
editing activities. You can remove sequences from a 
Timeline panel or add additional sequences to it, each 
sequence will appear as a tab within that Timeline 
panel. You can also open multiple Timeline panels, 
each within its own frame, with each containing any 
number of sequences. But for now, we’ll stick to 
working with a single sequence in our timeline.

B. Tracks: A sequence may contain several video and audio 
tracks. When you add a video, audio, or video+audio 
clip to a sequence, you need to specify which track or 
tracks it should end up in. You can target one or more 
audio or video tracks. The way you specify target tracks 
depends on the editing method you use, however, the 
easiest way to place a clip into a particular track is to 
drag it into the track you want to place it in.

C. Source Monitor: The Source Monitor is used to view and trim raw clips before you add them to a sequence. To 
view a clip in the Source Monitor, double-click it in the Project panel. 

D. Program Monitor: The Program Monitor is to the right of the Source Monitor and plays back the sequence of 
clips that you are assembling.

E.  Project panel: This is where you keep track of the many links to your project’s video clips, audio files, graphics, 
images, and sequences. You can use bins (a.k.a. folders) to organize your media assets.  For example, you might 
create bins for video footage, music, images, sound effects, and sequences. This makes it easier to find things and 
only see the kind of media you’re looking form.

F.  Media Browser: The Media Browser gives you access to all the media assets available on all of the hard drives 
connected to your computer. Use the Media Browser to import clips copied from tapeless video cameras, sound 
recorders, downloaded from media library sites, etc.  

G.  Effects panel: Commonly used effects are listed in the Effects Panel and are organized into two bins: Video 
Effects and Audio Effects. Within each of these bins, Premiere Pro lists effects by type in nested bins. Effects are 
organized as Presets, Audio Effects, Audio Transitions, Video Effects, and Video Transitions.

H.  Audio Mixer: The Audio Mixer tab allows you to adjust audio levels and related settings while listening to audio 
tracks and viewing video tracks. Each Audio Mixer track corresponds to a track in the currently active sequence 
and displays the audio tracks. Each track is labeled near the top of the Audio Mixer, and you can rename the 
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tracks by double-clicking the name. This is handy when you have to keep track of audio mixes with lots of layers. 
You can also use the Audio Mixer to record audio (e.g. voice over) directly into an audio track in your sequence.

I.  Effect Controls Panel: You use the Effect Controls panel to change settings for transitions placed in a sequence. 
Settings vary depending on the particular type of transition. Click the Effect Controls tab, and then click any 
clip in the Timeline to display the effect parameters associated with that clip.

J. Tools panel: The Tools panel contains the fundamental editing tools such as ripple and rolling edit, slip, slide, 
and razor.

K. Info panel: The Info panel displays data about the currently selected item, along with timecode information for 
clips under the current-time indicator in the Timeline.

A ten step guide through the basic editing workflow
1. Copy media from the camera (or P2 card) to a folder

Copy the entire contents of  the camera’s memory card into a dedicated folder inside your designated Project Folder, 
e.g. “/Volumes/MyExternalHD/Video Projects/Media/Card Name”. 

2. Preview and import media assets using the Media Browser

Prior to launching Premiere Pro you’ve collected a variety of  media assets (video, sound, images, etc.) and you’ve 
organized them in folders inside your Media folder inside your project folder.  You can browse through your folders 
and look at (or listen to) the assets you’ve collected using the Media Browser. The Media Browser knows how to make 
sense of  card based camera file structures (1). 

Selecting clips (2) and then right-clicking and selecting Import will import the files into your Project.

If  the files aren’t moved from the camera or media card to your hard drive, they will go offline if  the camera or 
media card is not connected to the editing workstation. Aways copy media from the camera to a folder in your 
Media folder before importing media.

There are three ways to import files into Premiere Pro:
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• Use the Media Browser panel. This is the most efficient manner
to browse through camera media and then import them into
your project, especially good when you only want to import
selected clips from the camera card.

• Choose “File > Import” from the menu bar and navigate to the
location of the file (this works best with stand-alone media files
like a QuickTime movie or audio file),

• Drag and drop the media file(s) from the Finder into your
Project pane (again, this works fine for stand-alone media files
like a QuickTime movie or audio file, but can be problematic with card-based camera file structures, so use the 
Media Browser when in doubt).

3. Review your footage setting in and out points using the Source
Monitor 

Double clicking on a video or sound clip in the Project Pane will open it in the 
Source Monitor. Here you can play the video (or audio) by clicking on the 
play button, you can also scrub back and forth by clicking and dragging the 
pointer (a.k.a. CTI or Current Time Indicator) along the numerical timeline 
under the picture. The space-bar acts as a toggle either playing or pausing the 
clip. 

Both the Source Monitor and Program Monitor provide a variety of  controls 
for video playback. You’ll use the Source Monitor to play or cue a clip and setting in and out points. You’ll use the 
Program Monitor to control playback of  the currently active sequence in the Timeline Panel. Click on a Sequence 
tab to make a sequence active, and preview it in the Program monitor. Double-click a clip in the Source panel or in a 
Timeline to preview it in the Source monitor. 

Most playback controls have keyboard shortcuts. When you use keyboard shortcuts to control video playback, make 
sure that the monitor you want to control is currently active, if  it’s not, simply click the video image in the monitor 
you want to make active. Here are some of  the playback controls:

• To play, click the Play button , or press L or the spacebar.
• To stop playback, click the Stop button or press K or the

spacebar. The button and the spacebar toggle between Play
and Stop.

• To play in reverse, press J.
• To play forward at increasing speeds, press L repeatedly.

For most media formats, clip speed increases from one to
two to three to four times.

• To play in reverse at increasing speeds, press J repeatedly.
For most media formats, backward clip speed increases
from one to two to three to four times.

• To play from the In point to the Out point, click the Play In 
to Out button.

• To play an entire clip or sequence repeatedly, click the
Loop button, and then click the Play button. Click the
Loop button again to deselect it and prevent looping.

• To play from the In point to the Out point repeatedly, click
the Loop button, and then click the Play In To Out button .
Click the Loop button again to deselect it and prevent
looping.

• To move forward a single frame, hold down the K key and
tap the L key, you can also use the right arrow key.

• To move back a single frame, hold down the K key and tap
the J key, you can also use the left arrow key.

• To play forward in slow motion, press Shift+L.

Is Premiere Pro acting strange and 
not doing what you expect it should?

This might be because a tool other than the 
default pointer tool is selected. To make sure the 
pointer tool is selected click on the 
first tool in the Tool Pane (the arrow) 
or press “V” which is the keyboard 
shortcut for the pointer tool.
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Premiere Pro links to your media assets, it 
does not really import them! 

Keep in mind that any media assets you import into 
Premiere Pro are not actually ingested into the program. 
Premiere Pro simply keeps track of where the media assets 
are located in the computer’s file system. This is why it’s 
imperative that you copy media from cameras and sound 
recorders to a folder inside your video project folder before 
importing them into  Premiere Pro. 



• To play backwards in slow motion, press Shift+J.
• To play around the current time, from two seconds before the playhead to two seconds after the playhead,

Option-click the Play In To Out button. Pressing Option (Mac OS) changes the button to the Play Around
button. The Play Around button is available to drag into the button bar.

Playback continues unless you specifically press spacebar to stop or another command. This feature supports real-
time adjustment of  common editing actions. For example, you could adjust a video effects while you are playing back 
in a loop. Some of  the actions that don’t stop playback include Keyframing of  effects, Interface items, Timeline 
items, Metadata entry (e.g. updating the description field or log notes), changing Audio parameters, Titling, and 
Zooming in and out of  the timeline.

In the Source monitor the timecode of  the current time position (indicated by the CTI) is shown on the left, while 
the duration of  the clip between the In point and Out point is shown in white on the right hand side of  the window. 
We’ll discuss In points and Out points below.
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4. Construct an assembly of your video sequence in the Timeline Panel

The Timeline Panel appears in a pane (usually in the lower right portion of  the workspace when you launch 
Premiere Pro or create a project unless you’ve created a custom workspace). You can close the sequences shown in 
Timeline panel by clicking on the ‘x’ in the sequence tab, or add additional sequences by double-clicking on the 
sequence names in the Project Pane, each open sequence will appear as a tab (A) within the Timeline panel. 

It is here in the timeline where you do most of  your video editing activity. You can stop and start the video by using 
the playback controls listed in the section above. As you view items in the Source Monitor, set in and out points, and 
then drag them in the desired arrangement in the timeline, you create a sequence of  clips which will in the timeline 
from left to right. To return to the starting position, click the “Home” key on the keyboard.

With items in the timeline, you can: 
(1) Adjust edit points, making clips shorter or longer, or stretch them over time; 

(2) Create multiple layers of video, e.g. titles, superimposed images, etc. 

(3) Create multiple layers of audio, e.g. voiceovers, music, etc.; 

(4) Add transitions, filters, special effects, etc. 

(5) When you have finished editing the timeline, you can play it back in real time or export it in a variety of formats 
directly from Premiere Pro.

The important editing operations will be demonstrated in the Video 
Tools class. We’ll cover some of  them in this handout, however, if  you 
need additional help with them, you are encouraged to check out the 
Lynda.com tutorials that cover editing with Adobe Premiere CC or 
make an appointment with your instructor for additional assistance 
with editing. 

5. Organize and annotate your media assets in the Project Pane

As the number of  media assets in your Project Pane begins to grow, 
you’ll soon have an unwieldy number of  clips on your hands. It can 
take a long time to find the clip you’re looking for when they are not 
annotated and/or organized in some way. The Project Pane has 
columns called “Description” and “Log Notes” you should use for 
identifying your footage. I suggest keeping the file names identical to 
the original. You can click and drag the names of  columns to 
reorganize the order they appear in as was demonstrated in Video 
Tools. You can create bins (a.k.a. folder) to organize your sequences, video clips, audio clips, music files, titles, etc. 
Bins should be used for organizing your project.  

Create new bins to group together related media assets. With the Project Window 
active, Choose File > New > Bin to create a new bin. Note the small icons next to 
each item in the Browser; these change based on the media type, and are a good 
way to see what’s in your Browser at a glance. You can also change the view of  
the Browser to either list or icons by clicking on the buttons in the lower-left 
corner of  the Project Pane. 

6. Continue working in the timeline, trimming and rearranging clips as
needed

After you’ve selected in and out points in the Source Monitor and moved a clip 
into the timeline you can still adjust in points and out points by trimming them. 
You trim by clicking and dragging the ends of  a clip in the timeline, notice as you 
hover the pointer over the start or end of  a clip, the cursor changes indicating 
that trimming mode is active. Other tools for trimming, including the ripple, roll, 
slip, and slide tools, are available and described later in this document.

If  you need to delete a gap in the sequence, simply select the empty space and 
press the delete key.
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Working with multiple sequences
You can work with multiple sequences 

in a single project. You might want to create 
a sequence for your “selects” (a collection of 
your better video clips strung together in 
one sequence), and then create another 
sequence in which you perform your 
editing, first to create a rough cut and then 
when you have your basic sequencing right, 
a fine cut. By doing the fine cut in a 
separate sequence, you can go back and use 
pieces of the rough cut if you change your 
mind or want to try another approach. 
Keeping around old drafts of your work in 
the form of sequences can come in handy. 
You might also create a new sequence 
when you want to try some experiments, 
but want to be able to go back to a stable 
baseline you’re happy with. 



You can drag clips around in the timeline in order to rearrange as you like. Dragging a clip from one position in the 
timeline to another in lifts it (leaving a gap) from its original location and overwrites it to the new location. 

Command-dragging a clip extracts the clip (rippling the gap) from its original location and inserts it, sliding all clips 
to the right of  that point to later in the edit.

To delete a clip in the sequence start by selecting a segment in the timeline and pressing the Delete key. This will 
leaving a gap in the sequence. To eliminate the gap and ripple the rest of  the sequence, delete the segment with the 
Delete key, and then right-click or Control-click on the gap and choose Ripple Delete.

Trimming in the timeline. Hover over a transition, and then when the cursor changes to a red bracket icon, you can 
drag to trim either side of  the transition. This will leave a gap between the clips equal to the amount you dragged. If  
you want to ripple the trim (closing the gap automatically), simply Command-drag. 

You will notice that sometimes you get audio clips out of  sequence. If  you want to make sure the 
audio and video clips that are linked together remain in sync, you need to make sure that 
“Linked Selection” is turned on in the upper left of  the Timeline Pane. When Linked Selection is 
on, selecting the audio or video of  a linked clip will select both. When it’s turn off, you can select 
the audio and video portions of  a linked clip separately. In addition, you can link and unlink clips 
using the  Clip > Link or Clip > Unlink menu commands. 

7. Work towards a fine cut of your sequence using additional editing tools

Once you have established the basic flow of  your clips in the sequence, it’s time to start fine-tuning your 
edit as you work towards a fine cut. Much of  this work will occur in your timeline.  So far we’ve done 
everything using the Selection tool (arrow, shortcut: V), for fine tuning your edits, you’ll find yourself  in 
need of  expanding your repertoire, enter the Tool Panel.

The Tool Panel offers a variety of  tools you’ll make use of  while fine-tuning your editing. When you 
select a tool, the pointer changes depending on the tool that’s currently selected. Short cut keys can be 
used instead of  clicking on the tool icons in this panel for faster editing, these are shown in parenthesis 
throughout this document.  These tools are best learned through experimentation so you develop a feel 
for what they do. To perform any of  these changes to a clip, select the tool and then perform the edit. 
It’s a good idea to go back to the Selection tool (V) when you’re done working in a tools so things will 
operate as you expect. If  you ever wonder why your mouse clicks don’t do what you expect them to do, 
check to make sure the tool you want to be active is actually active. It’s very east to accidentally select the wrong tool,  
for example, inadvertently typing a key on the keyboard that corresponds to a keyboard shortcut.

Selection Tool (V) 
This is the default tool and is used for common tasks in the timeline. To select the tool, either click the 
select button in the toolbox or press the V on the keyboard. To select a single clip or transition, click the 
clip or transition in the timeline. To select only the video or audio portion of  a clip, hold down the Alt 
key while clicking the clip. To select multiple clips, hold down the Shift key while clicking each required 
clip. Shift-click a clip again to remove it from the selection. To select multiple adjacent clips, you can 
drag a selection rectangle (marquee) around all the desired clips. Shift-drag to remove clips from the 
selection. To select all clips on a track (or multiple tracks), use the track selection tool instead.

Ripple Edit Tool (B) 
A ripple edit means moving an edit point and causing the rest of  the timeline to move the same 
amount to compensate. To perform a ripple edit, select the ripple edit tool. Position the mouse at the 
edit point in the timeline and drag left or right.

Razor Tool (C) 
The razor tool is used to cut a clip in the timeline into two separate clips. Click on the clip at the point 
where you want the cut to be made.

Pen Tool (P) 
The pen tool is used for creating control points (a.k.a. anchor points or keyframes).
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Track Selection Tool (A) 
The track selection tool is used to select all clips from a given point on a particular track in the timeline. 
Position the pointer where you would like to start the selection and click. To select an entire track, 
position the mouse right at the beginning of  a track. If  you want to select multiple tracks, hold down 
the Shift key while clicking.

Rolling Edit Tool (N)
A rolling edit involves moving an edit point without affecting the rest of  the timeline. The first 
(outgoing) clip is made shorter while the second (incoming) clip is made longer by the same amount, or 
vice versa. The result is that the overall length of  the program is not altered. To perform a rolling edit, 
select the rolling edit tool. Position the mouse at the edit point in the timeline and drag left or right.

Slip Edit Tool (Y) 
A slip edit means adjusting the in and out points of  a clip at the same time by the same amount in the 
same direction. The duration of  the clip stays the same. To perform a slip edit, position the mouse over 
the clip in the timeline, then click and drag left or right.

Hand Tool (H) 
The hand tool is used to drag the area of  the timeline visible in the sequence pane left and right.

Rate Stretch Tool (X) 
The rate stretch tool is used to change the duration of  a clip in the timeline while at the same time 
adjusting the speed to compensate. If  a clip is reduced in length using the rate stretch tool, it's speed 
will be increased, and if  the clip is increased in length using the rate stretch tool, it's speed will be 
reduced.

Slide Tool (U)
 A slide edit involves moving a clip left or right in the timeline while simultaneously adjusting other clips 
to compensate. The duration of  the clip you are sliding stays the same, the durations of  clips on either 
side will be automatically reduced or increased as required. To perform a slide edit, position the mouse 
over the clip in the timeline, click and drag left or right

Zoom Tool (Z) 
The zoom tool is used to zoom into portions of  the timeline. Clicking on the timeline while the zoom 
tool is selected zooms into a portion of  the timeline, while holding down the Option key while clicking 
in the timeline will zoom out from the timeline. While the zoom tool is active, you can click and drag 
around a rectangular area to magnify that portion of  the timeline.

Experiment with these tools and make sure you understand how to perform basic edits.

8. Finesse your audio tracks by adjusting audio levels

So far we’ve been focused on editing video clips which usually have a stereo track associated with them. Often you’ll 
want to edit just audio separately from the video, especially in terms of  audio levels. This section will get you started 
with this process, and in a future handout we’ll get into more details on how to use audio filters, effects, and the 
mixer, but for now, we’ll stick to the basics. 

Rubber banding. You can set key frames and adjust audio levels by using the “rubber banding” technique in the 
timeline. Here’s how it’s done:

1. Expand an audio track’s view by scrolling in the box with the audio track name to enlarge or or click and drag
the thin line between audio tracks.

2. Adjust the overall level of the track by dragging the yellow line in the audio track of the clip up or down.

3. To add keyframes, choose the Pen tool (shortcut: P) and then click on the yellow line. This will add a keyframe
(shown as a diamond) which you can click on and drag up or down to increased or decrease the volume. You can
also add keyframes by holding down the Command key while clicking on the line. You’ll see that the cursor
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changes to a pointer with a plus sign when you hold down the Command key and the pointer is over an audio 
track volume line.

4. You can click on the small diamond icon in the
audio track’s header (track patching info area),
and then select one of the following options
from the pull-down menu:

• Show Clip Keyframes: Animates audio
parameters for a clip, including volume
level.

• Show Clip Volume: Changes only a clip’s
volume level.

• Show Track Keyframes: Animates audio
track parameters, including volume, mute,
and balance.

• Show Track Volume: Changes only a track’s
volume level, uses Command-click. to
adjust the volume, drag up and down. To
change the timing of  a keyframe, Option-
drag left or right.

Using the audio mixer panel you can adjust the level 
(loudness or volume) and pan (for a mono clip determines where in the stereo field the sound is placed). Pan a clip all 
the way to the left and it will only come out the left speaker, pan to the right and it will only come out the right. 

The use of  the mixer will be covered in a future handout. For now, stick to Track Volume changes using the Rubber 
Banding technique and keep things simple for starters. 

Need additional audio tracks? By simply dragging an audio clip into an area below the last audio track, you can 
create an additional audio track. In Sequence Settings you can add and subtract tracks as needed, but the dragging 
technique is by far the easiest way to add audio tracks. 

Converting a stereo clips into two mono clips. Note that with stereo audio, the left and right audio tracks travel 
together. You can change this by:

1. Selecting a clip in the Project pane and right-click and and
choose “Modify > Audio Channels...”

2. A Modify Clip dialog box appears. Click on “Mono” to
change the clip to a Mono clip

3. Chose which channel should be used as the mono channel,
1 (left) or 2 (right) by clicking on the “Enable” check-box in
the track summary and then click “OK” when you are done.

4. You can preview the clip by pressing on the Play button and
scrub using the play indicator to the right of the Play
button. While the audio is playing the Play button changes
into a Stop button.

Note: if  the clip is already being used in your sequence as a stereo 
clip, you can’t change the properties of  the clip to mono. This is 
easily resolved by right-clicking on the item in the Project pane 
and choosing “Duplicate” which will create a duplicate item and 
this item (which will have “Copy” at the end of  the name) can 
then be modified.

1

2

3

4

2 3

4
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Audio monitoring. Audio levels are measured in decibels (dB), a 
measure of  a ratio compared to some absolute reference. It turns 
out that digital audio is measured in decibels (dB) below full scale, 
which on a digital meter is 0, thus, we see the meter is 
indicating numbers like -6 dBfs, which means 6 dB below full 
scale. This is why the numbers go 0, -6, -12, -18, -30. 

Furthermore, 3 dB is the smallest change you’ll notice, 6 dB is 
a more noticeable change  (roughly equivalent to double the 
sound energy, or half  the sound energy, depending on the 
direction you’re going, up/louder or down/softer. Always keep 
and eye on your audio meters when working with audio. 

If  levels average on the low end of  the scale (1), unless your video 
is intended to be a very quiet experience your video will not play loud enough. You want most peaks to hover under 
the peak indicators (2). The yellow peak indicators show you the level of  recent, rapid peaks that you might miss 
looking at the green peak indicators. When your audio levels are too loud, it will be indicated by the red peak 
indicators (3). If  you allow sounds to go over this peak setting, your audio will distort when played back.  It’s best to 
keep the average peaking level of  your audio track around the -12 to -6 dBfs range (4), reserving the space above -6 
dBfs as headroom for the occasional transient peak which may hit as high as -3 dBfs. If  you’re creating anything 
intended for broadcast, the rule of  thumb is to keep all of  your peaks under -10 dBfs, but you’ll see different 
specifications our there. For web video we typically have our audio levels run a little hotter than broadcast standards 
because of  the variety of  playback situations.

9. Add titles as needed

To add a title over your video, follow 
these steps:

1. Choose Title Menu > New Title.

2. Select from the options in the
pull-down menu: “Default still” is
probably the best choice starting
out. Premiere Pro comes with a
range of pre-designed templates
from which to choose, or you can
also customize and save templates
of your own.

3. The “New Title” dialog box will appears. Set the formatting options.

4. Type the text you want on the screen, keep text away from the edges, and avoid serif type.

5. When you’re done, click on the “OK” button.

Designing titles from scratch is fairly easy. The Title MainPanel in the Title Tool allows you to see your title as you 
design it. Most of  the tools are to the left, in the Title Tools panel. You can easily duplicate titles so once you’ve got a 
style you want, you simply duplicate the title in the Project Pane and rename and edit the new one as needed.

10. Export your sequence

Follow these steps to export a compact, yet high quality version of  your video using the H.264 video codec. This is 
the codec currently used by a majority of  video streaming sites because it’s relatively high quality with a compact file 
size. We’ll call this “Distribution Quality,” since there are some compromises in image quality in order to achieve the 
smaller file size. On the other hand, an “Edit Master Quality” export is a video exported to a very high quality 
format (e.g. ProRes 422) which has a much large file size. Distribution formats favor compact size over quality, while 
Edit Master Quality formats favor quality over file size. From an Edit Master you can make a variety of  Distribution 
Format videos. But for now, here’s how to export a “Distribution Quality”video for screening and critique:

1. Select the sequence you want to export in the Project Pane or make sure it’s the active sequence in the Timeline

2. Choose “File > Export > Media...” from the menu (shortcut: Command+M)

4

1

2

3
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3. Make sure the default “Scale to Fit” is selected. Unless you have a reason for changing this, leave it be.

4. For Source Range: select “Entire Sequence,” this will export your entire sequence. You can scroll through the play
bar in this dialog box to make sure you don’t have extra bits of video after the end of the video. You’ll see the 
total running time of the sequence as the number on the right hand side under the preview of the video. the 
area on the sequence you wish to export (on the left hand side of the window under the image) Select the 
“Source” tab. Only use if you are exporting only a portion of your outputted video. For now select “

5. For Format: select
“H.264” from the 
pop-up menu, 
make sure Match 
Sequence Settings 
is NOT selected.

6. For Preset: select
“Match Source - 
High Bitrate” to 
match the source 
video settings as 
closely as possible. 
As long as your 
sequence was set 
up as 
recommended 
earlier in this 
handout, 
everything should 
be fine.

7. Choose a name and
the destination folder by clicking on the blue default file name. Name your file following some scheme you’ve 
developed for yourself.  When you click on the file name it will bring up a “Save As” dialog box. Here you 
choose the name of your file and select the destination folder. When done, click “Save”.

8. Click the Export button at the bottom of the frame to begin exporting. A progress box will display the progress of 
the export.

9. View your exported file full-screen and with either quality closed-ear headphones (available in the classroom and
Media Studio editing area) or high-quality near-field monitors. 

10.If you’re happy with the video, copy it into the designated folder for screening and critique.

Media offline, where is the file?
In the event Premiere Pro can’t find one or more of  the media assets you’re using in your project, it will put up a 
dialog box asking you to locate the media assets it can’t find. This often happens if  you rename the folder the media 
asset is in, or move the folder, or if 
your media happens to be on a 
hard drive that’s not currently 
mounted on the desktop. This can 
also happen when you use media 
on an external device (e.g. tapeless 
camera or audio recorder) without 
first moving the media files to a 
media folder inside your project 
folder on your external hard drive.

In any of  these situations, 
Premiere Pro will put up a dialog 
box that looks like the one 
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pictured above. You can skip a 
single file or all of  the files that 
Premiere Pro is looking for, 
however, in most cases you’ll want 
to select “Locate” and then 
navigate to the location of  the file 
in question and select it in the file 
list, after clicking “Locate” you’ll 
see a dialog box like this. Navigate 
to the location of  the file and 
select it from the list of  files: 

After clicking  “OK” Premiere Pro 
may come back with other files that need to be re-linked, or when there are no more files that need to be re-linked, it 
will put up a progress dialog letting you know that it’s in the process of  re-linking files. If  there are a lot of  files that 
need to be relinked, Premiere Pro might take some time to do this, sit tight, and soon all of  your media will be ready 
to go. The good think is if  a group of  files are all in the same folder, Premiere Pro will link to all of  them at the same 
time, so you often don’t need to do this on a file by file basis.

Video formats and rendering
There are a variety of  video formats our there, some camera formats are designed to balance between size and 
image quality and require a lot of  computer horsepower to reconstruct the frames from the storage format. On the 
other hand, there are some editing formats that are designed for ease of  editing and computers have an easier time 
playing them, but they take up way more storage space. Then we have mastering formats designed for no-
compromise image quality and distribution formats that are designed 
to be as compact as possible, sacrificing quality, Each format has its 
own quirks. Mastering formats usually take up too much room to be 
viable distribution formats. Often camera formats require a lot of  
computer processing for playback. Many distribution formats degrade 
picture quality appreciably. Fortunately Premiere Pro is able to 
directly edit common camera formats, but for any effects or 
transitions, it has to render out the video because it can’t play it back 
in real-time, it takes up too much of  the computer’s resources 
computing the transition or effect. 

This is where rendering comes in: rendering is the process of  pre-
computing (a.k.a. pre-baking) any transitions or effects or conversions 
that are needed for full-quality, real-time, playback. To render the 
currently active sequence, choose “Sequence > Render Entire Work 
Area” from the menu bar. The work area can be adjusted to a specific area so you need only render part of  your 
sequence to see real-time playback.

While rendering Premiere Pro will show you a progress indicator with an estimate of  the time it will take to render 
your project. Depending on how long your sequence is and how many transitions and effects are in it, this could take 
a while.

The colored lines along the top of  the timeline tell you the rendering status of  the video. The color indicators are 
adaptive and based on your specific system If  you have a high-performance graphics engine and/or lots of  cores, 
Premiere will be able to play video that otherwise it would have to render ahead of  time for full-quality, full-frame 
rate playback.  Here’s what the colors are telling you:

• No color. Premiere can play the original source media in real time full-quality and full-frame rate without
breaking a sweat.

• Yellow. Premiere most likely can play back the original source media in real time on most hardware but it will
probably break a sweat in the process.

• Red. Premiere may or may not be able to play back the video real time, and it it’s certainly in for a workout.
For simple effects, it will probably provide real-time playback, on the other hand, for more complex effects, it’s 
going reduce quality and/or frame rate in order to do it’s best to play back in real time with a lot of  huffing 
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and puffing. If  you want smooth, high-quality real-time playback, you will have to render the work area or 
entire sequence. 

• Green. This portion of  the timeline has been rendered (a.k.a. pre-baked) and Premiere will play it back in real
time without breaking a sweat because all of  the heavy lifting has been accomplished during the rendering 
process.

If  you have a fast system (lots of  cores, two or three gigabytes per 
core, fast drives, and a supported graphics card), playback of  yellow 
sections and many red sections will be in real time. With a slower 
computer, you'll end up having to render more frequently.

The Dropped Frames Indicator provides feedback in the event 
Premiere needs to drop frames to keep up with real-time playback. 
To turn on this feature, open the Program Panel menu and choose 
Show Dropped Frames Indicator. 

Even if  you drop frames during playback, you don’t have to render. 
Adobe Premiere Pro defaults to playback of  1/2 quality. Unless you 
are viewing full screen you don’t need to see every pixel while 
editing. When you pause playback, Premiere Pro shows you the full 
resolution by default, which is why you may notice the video looks better when paused. 

While editing Premiere will do it’s best to play back footage, but it may be doing this at 25% or 50% of  the original 
resolution and only showing you full resolution image when the video is paused. This speeds up the editing process, 
but when you’re done editing, you probably want to look through your video once in full resolution before you do 
your final export, and this is when you should render the entire sequence and then do a final look-see before 
exporting. It’s better to fix problems now rather than discover then during screening and critique!

Resources for further study
You may need to spend additional time on your own outside of  the Video Tools sessions in order to develop the 
fluency required to complete your video production projects. All of  the URLs in this PDF are clickable links and 
should work as long as your PDF reader is not blocking them:

Tutorials
• “How to create a video story with Premiere Pro,” adobe.com, this is a wonderfully short and concise tutorial.

• “Adobe Premiere Pro CC Essential Training” (2015) with Ashley Kennedy Lynda,com, a very compressive
tutorial, however, since each module comes with a transcript, you can scan the transcript and jump right to
point in the tutorial you need to figure out how to do something.

• Editing Skills: Featuring Adobe Premiere Pro CC by Larry Jordan, an excellent course that dooes not require
any prior knowledge of  Premiere Pro and is ideal for a beginning editor.

Reference
• “Adobe Premiere Pro Help” and “Adobe Premiere Pro CC tutorials,” adobe.com, https://helpx.adobe.com/

premiere-pro/

• Premiere Pro, Basic Workflow,” adobe.com, http://help.adobe.com/en_US/premierepro/cs/using/
WS4C20B718-E29E-41ee-B3D0-0CD37A1D94F7.html
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Glossary
Here are some terms you will encounter when editing digital video. While most terms are universal, some may apply 
specifically to working with Adobe Premiere Pro.

4:3. The aspect ratio of  early film and video, as opposed to the 16:9 ratio of  high 
definition video and many modern film releases. Also known as fullscreen. See aspect 
ratio.

16:9. The aspect ratio of  most widescreen video (may be either standard or high 
definition), and many modern film releases, as opposed to the classic 4:3. See aspect 
ratio.

Alpha Channel. The ability of  an image or video clip to become semi- or fully 
transparent, allowing the clips on the tracks below to show through.

Anamorphic. Refers to widescreen video that has been “squeezed” to fit into a 4:3 
aspect ratio. It must be unsqueezed for playback in the proper aspect ratio. See aspect 
ratio.

Aspect ratio. The ratio of  the horizontal dimension to the vertical dimension of  a picture. Most widescreen video is 
1.78:1 (a.k.a. 16:9), and standard-definition video / early film is 1.33:1 (4:3). Wider aspect ratios are typical in 
theatrical film and video, such as 1.85:1 (the 35mm wide screen standard) and 2.35:1 (a.k.a. “CinemaScope” or 
“Scope”).

AVCHD. A modern, high definition video codec used for consumer cameras that shoot to some variation of  tapeless 
media (flash cards, hard drives, etc). Considered by many as the successor to the HDV tape format. Uses H.264 
specifications for video compression.

Audio Meters. Displays the level (in dB) of  the currently playing audio. See also Decibel.

Bin. A folder in which to organize clips and sequences. 

Byte (B). Unit of  binary data storage, technically 8 binary bits (each bit is a binary digit, either 1 or 0). Think of  it as 
the equivalent of  a single character in a word processing document. Typically a single pixel (dot on the screen) of  
video requires three bytes of  storage. See Megabyte, Gigabyte.

B-roll. Shots in a documentary that are used to illustrate what an interviewee is talking about, or to cover breaks in 
an interview. Often used to refer to the footage that is shot for the purpose of  using later as cutaway shots. 

Capture. The process of  transferring digital video tape material from a camera into a non-linear editing system. See 
also Import and Log and Transfer.

Clip. A portion of  video or audio.

Codec. Compressor/Decompressor. See Appendix A: Understanding Video Compression, and Compression.

Compression. The process of  reducing the amount of  digital information required to store a file. 

Cutaway. A shot of  an image or action in a film which is not part of  the main action, sometimes used to cover breaks 
in a scene’s continuity.  In documentary often called “B-roll.” 

Cutting on action. Editing two shots at a point where the movement in the first one is not yet completed and where 
the movement in the second one has already begun. Along with an angle change can be a very seamless edit 
providing the viewer with the impression that the action is continuous and uninterrupted.

Dailies (Rushes). In film production, all the processed footage that was shot yesterday (or on video productions, the 
same day), usually watched by the director and other crew to make sure everything came out as intended.

Decibel (dB). A measurement of  sound level. Our ears respond to changes in volume in a non-linear manner. A 
decibel is a logarithmic scale of  loudness. A difference of  1 decibel is the minimum change in volume that we can 
perceive, 3 dB is a modest change, and 6 decibels perceived as a doubling of  volume. Decibels are used in two ways: 
audio signal levels while editing (e.g. if  you increase the level from 0dB to 6dB in Final Cut Express you are doubling 
the loudness of  a sound), or to measure sound pressure levels in the environment. 
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Digitizing. The act of  taking analog video and converting it to digital form. The term is incorrectly used 
interchangeably with ingest or capture, which is the process of  transferring a digital video format into a non-linear 
editing system (it’s already digital, so you are simply capturing or ingesting, you’re not actually digitizing). 

Double-system sound. The technique of  recording sound and image using separate recording devices. In film 
production this is the normal methodology since film camera can’t record sound, however, it is sometimes used in 
video as well when mobility is required by the sound recordist who may want to avoid running wires to feed the 
video camera with the audio signal.

Dropout. Loss of  a portion of  an audio or video signal, usually caused by an imperfection in the tape’s coating or 
dirt covering a portion of  the tape. HDV, due to its long-GOP format is particularly susceptible to dropouts because 
a dropout is likely to affect multiple frames. Hi8 was also a format notorious for drop outs.

DV. A standard definition video codec commonly used for consumer cameras that shoot using MiniDV tapes. DV 
cameras are inexpensive, and a wide range of  computers can be used to edit it, as it’s both standard-definition and 
intra-frame (see Codec). Wildly popular in the early 2000s, it has been overtaken by consumer HD formats like HDV, 
and more recently, AVCHD.

DVCPROHD. A high definition definition intra-frame video codec used by Panasonic prosumer and professional 
cameras.

Field. In interlaced video, one half  of  a complete video image (frame), containing all the odd or even scanning lines 
of  the image. See Interlace Scan.

Filter. An effect applied to a clip in a non-linear editing system.

Foley. Creating sound effects by watching the picture and mimicking the action, often with props that do not exactly 
match the action but sound good. For example, walking on a bed of  crushed stones in order to simulate walking on 
the ground, or hitting a watermelon to simulate a blow to the head.

Format. The video codec, resolution, and frame rate used for a production. See Appendix A: Understanding Video 
Compression.

Gigabyte (GB). A unit equivalent to 1 billion bytes. An hour of  DV video requires 12 GB of  storage, AVCHD 
around 10GB, and Apple Intermediate Codec around 23GB.

H.264. a.k.a. MPEG-4 Part 10, Advanced Video Coding (MPEG-4 AVC. A video encoding format that is currently 
among the most widely used formats for consumer camcorders and distribution of  video content.  H.264 is one of  
the video encoding standards for Blu-ray Discs and is widely used by streaming internet sources, such as videos from 
Vimeo, YouTube, the iTunes Store, and various HDTV broadcasts standards for terrestrial, cable, and satellite 
distribution.It is lossy compression in the strict sense, although the amount of  loss may sometimes be imperceptible 
depending on the actual profile and data rate used to encode the video. It is possible to create virtually lossless 
encodings when encoding at high data rates.

HDV. A high definition video codec commonly used for consumer HD cameras that shoot using MiniDV / HDV 
tapes. It is innovative in its use of  the MPEG-2 codec to fit more data on the same cheap MiniDV tapes that DV 
cameras use. Rapidly being eclipsed by AVCHD in the consumer market.

Interlace Scan. A process in which the picture is split into two fields by 
sending all the odd numbered lines to field one, and all the even 
numbered lines to field two (see illustration). Field one is then displayed 
first, followed by field 2. This process was necessary in the early days of  
television broadcast when there was not enough bandwidth within a 
single television channel to send a complete frame fast enough to create a 
non-flickering image, and has unfortunately been carried over to modern 
systems, though progressive scan is now more common. See also Field.

Import. The process of  linking a Final Cut project to a media file, so that 
the file exists in a Final Cut project but isn’t actually moved from it’s 
location in the Finder.

Intra-frame compression. This means that each frame (the individual 
pictures that make up a movie) is compressed separately. The codec basically sees the video as a series of  still 
pictures, and deals with each one independently of  the ones around it. Intra-frame is usually preferable to inter-
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frame, as it’s easier for the computer to work with while editing, but it also produces bigger file sizes and thus requires 
more hard drive storage to work with. Examples of  intra-frame formats include DV, DVCPRO HD, and Apple 
Intermediate Codec.

Inter-frame compression. This means that the frames are not only compressed individually, but also rely on each 
other to determine the best method of  compression. The codec looks at one frame, then looks at the next to see 
what’s changed, and records only the changes instead of  the whole frame. Inter-frame is often used by higher-
performance codecs to fit more video onto the recording media, but is more difficult to edit with, as the computer 
has to work harder at decoding the frames (it’s kind of  like assembling Ikea flat-pack furniture from the instructions, 
the package is compact, but there’s a lot of  work involved in reconstituting the object). While you don’t need as much 
storage space, you need more computational power, and therefore newer, faster computers are required to edit inter-
frame codecs. The most widely used inter-frame codecs at this time is H.264.

JPEG. Joint Photographic Experts Group. A lossy standard for compressing still images. JPEG-2000 provides lossless 
compression.

Keyframing. Setting the level of  a filter, or other effect’s parameter, so that it can be changed over time with the use 
of  other keyframes.

Kilobyte (K). One thousand bytes, or 1,024 bytes depending on whether a computer system displays size values in 
base 2 (binary) or base 10. Today, Macs and most external hard drive manufacturers use base 10, where Windows 
computers utilize base 2.

Letterbox. Placing a wide screen image (typically 16:9) in a conventional 4:3 video frame by placing black bars at the 
top and bottom of  the screen. See also Aspect Ratio and Pillarbox.

Megabyte (MB). A unit equivalent to 1 million bytes, or 1,048,576 bytes (1,024 squared). See Gigabyte and Kilobyte.

MOS. Minus Optical Sound. Shooting image without recording sound. 

MPEG.  Moving Picture Experts Group. A standard for compressing  moving pictures. MPEG-1 video uses a bit rate 
of  1.2 Mbps (Mega Bits per Second), the speed of  CD-ROM. MPEG-2 supports much higher quality with a bit rate 
from 2 to 10 Mbps. MPEG-2 is the format specified in the DVD standard and is also used in HDTV broadcast. 
MPEG-4 is the modern, highly efficient equivalent, intended for a range of  applications from web video and mobile 
devices to Blu-ray discs and HDTV broadcast. See also H.264.

Non-synchronous sound (non-diegetic). Sound that is not clearly matched to the image or something happening 
offscreen.

P2. A proprietary memory card format developed by Panasonic for use in their prosumer and professional 
camcorders. It consists of  four high-speed SD cards ganged into a RAID array so that the camera can write to the 
cards at a much higher data rate than would be supported by a single SD card. 

Paper edit. The process of  creating a preliminary edit (usually an assembly edit) of  your documentary using paper 
transcripts. Some people actually cut out pieces of  paper, others highlight key text and pull from that. In the old days 
of  linear video off-line editing, paper edits saved lots of  painful video editing time. Today with non-linear editing 
with all their tempting bells and whistles, paper edits can help you focus on ideas and concepts rather than editing 
rigamarole. Paper edits are a wonderful way to work towards the rough cut by helping you focus on structure rather 
than interface. 

Petabyte. 1,000 Terabytes, or 1 million Gigabytes.

Pillarbox (curtain). Placing an image in a frame with a greater aspect ratio than it’s own by placing black bars at the 
left and right sides of  the screen. See also Aspect Ratio and Letterbox.

Pixel. Picture Element. The basic unit from which a digital image is made. Essentially a dot with a given color and 
brightness value. Standard Definition images are usually 720 x 480 pixels, and High Definition is usually 1920 x 
1080 pixels. High-end professional cameras can record up to 4K (4096 x 2048).

Program Monitor. Displays the open sequence in the Timeline.

Progressive scan. An image scanning system where each line is displayed progressively (1, 2, 3, 4, 5 ...) in contrast to 
interlaced scanning. Computer monitors use progressive scan, and most HD formats includes several progressive 
scan variants. Video has historically been 60i (60 interlaced fields, a.k.a 30 frames per second). Progressive scan offers 
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an image that is well suited for web video and for display on computer 
monitors and flat-screen displays.

Pulldown. Video is often shot at 24 progressive frames per second (to 
mimic the “film look”), but recorded at 30 interlaced frames per second. 
Pulldown is a method for recovering the “embedded 24” and putting it 
back into a native 24 (see illustration).

Resolution. The measure of  pixels in the frame, directly related to the 
amount of  detail in an image. Higher resolution means more detail. 
Also used to describe the size of  an image, usually expressed in pixels, 
e.g. a high definition video frame has 1920 x 1080 pixels or 1280 x 720 
pixels.

Ripple Edit. A ripple edit changes the duration of  a clip by extending/trimming the in/out points.

Roll Edit. A roll edit allows you to move the edit point between two clips, extending/trimming the in/out points of  
the clips.

Scratch Disks. Location where Premiere Pro stores captured  footage from a camera or preview footage used in 
editing. When working with Premiere Pro you should avoid changing the default setting of  Scratch Disk, which is to 
put these files in the same folder as the project.

Sequence. A group of  audio/video clips, images, text, and any other elements that make up your movie.

Single system sound. A method of  recording sound and picture on the same device, often used in video production. 
See also double system sound.

Slate. 1. A device used to place an identifier in front of  the camera at the beginning of  a take. When shooting double 
system sound, the clapping motion and the clapping sound is used to synchronize the audio to the picture in post 
production. 2. A shot or portion of  a shot in which a slate or other identifying information appears. Often master 
tapes will include a slate and countdown prior to the start of  the show.

Slide Edit. A slide edit allows you to change the location of  a clip in the timeline by changing the in/out points of  the 
neighboring clips.

Slip Edit. A slip edit allows you to change the in/out points of  the clip itself  without changing it’s position or in/out 
points in the timeline.

Snapping. Allows easy moving around of  timeline clips by automatically “snapping” the edges of  clips together 
when they are brought close to each other.

Source Monitor. Displays a single clip from the Project Pane or from within the sequence in the Timeline.

Stock footage. Motion picture footage from previously existing films, filed in film libraries or archives, which is 
incorporated into a new film, usually to provide scenic background or for stock situations and settings, such as war 
scenes or foreign locations. 

Synchronous sound (sync sound, diegetic). 1. Recording sound in synchronization with recording image. Can be 
single- or double-system. In single-system sound recording the camera records sound and image, with double-system 
sound recording, the camera is used to record images and a separate sound recorder is used for sound. 2. Sound 
whose source is apparent and matches the action in a scene. See non-synchronous sound. 

Target Bit Rate. When compressing video, specifying how much data bandwidth is available to encode video 
information over time. Codecs can range from just a few Mbps to hundreds. Usually, the higher the bit rate, the 
higher the quality and the larger the file size.

Terabyte. One trillion bytes. An hour of  high-definition video at a resolution of  1920 x 1280 might take about one 
terabyte to store in an uncompressed format. Acquisition formats like HDV involve significant levels of  compression 
in order to reduce the data required to store video.

Timeline. Displays video sequences, playback is displayed in the Program Monitor. 

Timecode. A time reference used to identify each frame of  video, typically written or displayed as “02:23:43:02” 
designating hours : minutes : seconds : frames. A semi-colon between the seconds and frames typically indicates 
drop-frame time code (in which some numbers are skipped in order to align time code with real time).
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Tool Palette. The group of  tools that facilitate timeline editing and image manipulation.

TV Safe. The area of  the video image which will normally appear on a home television set. Due to the design of  
CRT monitors, they “over-scan” the image, which means the edges of  your video will not be visible. You can’t be 
sure that something that appears in the frame on your computer screen will actually be seen by “viewers at home”, 
so it has become standard to keep titles within an area called “title safe” and the rest of  the action within “action 
safe.” Non-linear editing system and DVD authoring systems have guidelines you can turn on and off  to see these 
margins. Many flat-screen TVs still overscan video so this is not a thing of  the past.

USB (Universal Serial Bus). A data transfer standard used to connect computers, hard drives, cameras, scanners, 
printers, etc. While USB 1.0 is a comparatively slow standard, USB 2.0 (a.k.a. Hi-Speed USB) is fast and is widely 
used for connecting cameras and external hard drives to a computer. USB 3.0 provides even faster data transfers 
than either USB 2 or legacy FireWire connections.

Widescreen. A general term for presentation using a screen with an aspect ratio greater than 1.33:1 (4:3). See Aspect 
Ratio.
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Creative Commons Share-Alike Attribution license may be found at http://creativecommons.org/licenses/by-sa/
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Summary of commonly used Adobe Premiere Pro keyboard shortcuts

Arrow tool V  Used for selecting objects within the workspace

Hand tool H
Zoom tool Z
Timeline zoom in =
Timeline zoom out -
Zoom into sequence/zoom in or out \
Maximize Frame Shift + `

Play in Reverse J A 2nd, 3rd, and (sometimes) 4th press of the J will speed up reverse playback

Toggle Playback K   (or spacebar)
Play Forward L  A  2nd, 3rd, and (sometimes) 4th press of the L will speed up forward playback

Previous edit Page Up
Next edit Page Down

Mark in  I Set the In point of  a clip or a position in the timeline

Mark out O  Set the Out point  of a clip or a position in the timeline

Clear in D
Clear out F
Clear in and out F

Insert F9
Overwrite/overlay F10 
Razor blade C 
Pen tool P
Trim back Option + left arrow
Trim forward Option + right arrow
Trim in and out point mappable
Roll edit N
Slip slide Y
Snapping S
Replace Option - drag
Lift ;
Extract ‘
Mark clip Shift + A
Marker Num *
Matchframe M
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